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LabVIEW  Datalogging and Supervisory 
Control Module Run-Time System 
Release Notes
Version 7.0

Welcome to the LabVIEW Datalogging and Supervisory Control (DSC) 

Module Run-Time System. This document describes installation, new 

features, upgrading, and known issues for version 7.0. For recent 

information not included in these release notes, refer to the 

dscrt_readme.txt file.
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System Requirements

The DSC Module Run-Time System runs on any system with the following 

minimum specifications:

• Windows NT 4.0 or Windows 2000/XP/Me/98. If you are running 

Windows NT, you need service pack 6a and the 6a Security Rollup 

Package, which are included in the July 26, 2001 security update 

available at www.windowsupdate.com.

• 128 MB of RAM minimum, 256 MB recommended.

• 200 MHz or higher processor speed, 500 MHz recommended.

• 400 MB of disk space to install the DSC Module Run-Time System 

and have swap space available. Increasing your computer resources 

has a significant effect on performance of DSC Module applications. 

• 800 × 600 or better monitor display.

Compatibility Issues

Citadel Database Compatibility
This version of the DSC Module Run-Time System includes Citadel 5, a 

new version of the historical database. The DSC Module Run-Time System 

version 7.0 logs to and retrieves from Citadel 5 databases only. You must 

convert existing databases to Citadel 5 if you want to use them with the new 

DSC Module Run-Time System. Refer to the Convert Citadel Databases 

section for information about converting your databases.
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Installation

Before You Install

• Make sure that you meet the system requirements listed in the System 

Requirements section of this document.

• If you have a previous version of the DSC Module Run-Time System 

installed, either uninstall that older version or plan to install this 

version into a different directory. 

• If you want to preserve custom settings used in your previous version 

of the DSC Module Run-Time System, save all .ini and .cfg files in 

the LabVIEW 6.x directory to a backup location, then copy them to 

the relevant location after installing version 7.0. 

• If you have Microsoft SQL Server version 6.5 or earlier on your 

computer, you must upgrade to Microsoft SQL Server version 7.0 or 

later before installing the DSC Module Run-Time System.

• Under Windows Me/98, you cannot browse OPC server computers 

across the network unless the Remote Registry Service is installed. For 

more information about installing Remote Registry Service, refer to 

the Microsoft Web article about how to install remote administration 

services. 

Installing the DSC Module Run-Time System
Complete the following steps to install the DSC Module Run-Time System.

1. Insert the DSC Module Run-Time System CD in your CD-ROM drive.

2. Run the installer. Run x:\setup.exe where x is the letter of your 

CD-ROM drive.

3. Follow the onscreen instructions. 

4. Restart your computer and log on to your computer as an 

administrator. When you reboot, the MSDE setup might take awhile.

Additional Installations
In addition to the DSC Module Run-Time System itself, you might need 

to install additional drivers or data servers for use with your application 

software. Refer to the documentation for your application software for 

installation instructions.

Install the Application Software
Follow the instructions provided by the system developer for installing the 

application software. After installing the files, note the location of the .scf 

and .ccdb files.
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Update Preference Files
Refer to the documentation for your application software to ensure any 

specific preference files for the application are placed in the correct 

locations. These files contain non-default settings for DSC Module 

utilities. You can edit these files with a simple text editor such as Notepad. 

Specific instructions about these preference files should be included with 

your application software.

Finish Server Setup
If you are using National Instruments IAS/IAK device servers, you might 

need to resolve the paths to the servers stored in the .ccdb file. Use the 

Server Explorer to do this. The Server Explorer is installed when you install 

the DSC Module Run-Time System. Start the Server Explorer from your 

Windows program menu or from the Tag Configuration Editor, select 

File»Open, locate the .ccdb file for your application software, and choose 

File»Set this file as Active CCDB.

VI-based servers (if used by your application) provide their own Server 

Registration VIs.

Configure LabVIEW Startup 
Launch the DSC Module Run-Time System. The first time you run it, 

you might want to configure one or more startup VIs. These startup VIs are 

the user interface panels that appear when you launch the DSC Module 

Run-Time System. Select Tools»DSC Module»Advanced»Startup VIs 

from your application. Use the Configure Startup VIs dialog box to locate 

the appropriate startup VIs, as identified in your application software 

documentation. 

If your application starts the Tag Engine when it launches, and the servers 

are not registered properly, you will receive error messages identifying the 

servers that did not start. Consult your application software documentation 

for more information about which servers are required, and how to register 

them. 

Uninstalling the DSC Module Run-Time System
To uninstall this DSC Module Run-Time System, select Start»Settings» 

Control Panel»Add/Remove Programs. Select National Instruments 

Software and choose to remove the NI LabVIEW DSC Run-Time 

System 7.0.
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New Features for Version 7.0

The following sections describe changes to existing features and new 

features available in this version of the DSC Module Run-Time System.

Citadel 5 Database
The DSC Module Run-Time System version 7.0 includes Citadel 5, a new 

version of the Citadel historical database. Citadel 5 introduces data access 

from ADO clients and improved ODBC support.

Database Names
Citadel 4 identified databases exclusively by their path; Citadel 5 now uses 

database names. Because of the new Citadel 5 format, the Historical Data 

VIs have been modified, the Tag Configuration Editor uses a new .scf file 

format, the ODBC data source setup has changed, and the Historical Data 

Viewer has been updated. 

Conversion to Citadel 5 Format
The DSC Module Run-Time System version 7.0 logs to and retrieves from 

Citadel 5 databases only. You must convert existing databases to Citadel 5 

if you want to use them with the new DSC Module Run-Time System. 

Refer to the Convert Citadel Databases section for information about 

converting databases.

Time Zones and Daylight Savings Time Information
As with Citadel 4, times in Citadel 5 are stored in UTC (Coordinated 

Universal Time). In addition to this, the DSC Module Run-Time System 

Tag Engine and Citadel 5 now store the time zone with every point and 

alarm logged, which allows you to determine the local time when the point 

was logged. This addresses problems of both data logged in another time 

zone and daylight savings time (CST and CDT are considered two different 

time zones in this scheme). You can get this information using extra 

columns in the SQL query. 
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Citadel 5 ODBC Data Source
As with Citadel 4, you must have an ODBC data source for Citadel 5 as 

described in the LabVIEW Datalogging and Supervisory Control Module 

Run-Time System Help. However, the following changes have been made to 

the National Instruments Citadel ODBC Setup dialog box:

• ODBC setup now asks for a Database URL instead of a database path. 

Database URL is the computer and database name where data for the 

source are stored, for example \\computer_name\my_database. 

Database URL should match the existing local or remote database you 

intend to access. 

• The ... button allows you to browse local and remote databases. 

• The Test Connection button allows you to test the connection you are 

setting up.

Expanded Access to Citadel 5 Data 
The Citadel 5 ODBC driver is compliant with SQL 92 and ODBC 2.5 

standards. All clients that follow these standards can retrieve data from a 

Citadel 5 database. ADO clients now can use the ODBC driver through the 

Microsoft OLE DB Provider for ODBC Drivers to access the Citadel 5 

database. You can use the MS Query wizard to build queries. 

Creating a Data Link for the ODBC Data Source

If you want to access Citadel data from an ADO client, you need a data link 

to ODBC. You might be able to create the data link from within your ADO 

client, but you might be required to create it multiple times. Alternatively, 

complete the following steps to create a data link once that can be stored 

anywhere on your system or network. 

1. Create a Citadel 5 ODBC data source, if you have not already done so.

2. Create a new text (.txt) document. 

3. Right-click the new text document and rename it to have a .udl 

extension, for example data_link.udl. A warning might appear, 

explaining that changing file extensions could cause files to become 

unusable. Disregard this warning. 

4. Right-click the .udl file and select Properties. In the dialog box that 

appears, click the Provider tab and select Microsoft OLE DB 

Provider for ODBC Drivers. 

5. Click the Connection tab and select your Citadel 5 ODBC data source 

name.

6. Click the OK button.
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Citadel 5 Tables
Citadel 5 tables are different than Citadel 4 tables. For more information 

about Citadel 5 tables, refer to the Update SQL Queries section of this 

document.

New Version of Historical Data Viewer
The Historical Data Viewer that comes with this version of the DSC 

Module Run-Time System allows you to view both Citadel 4 and Citadel 5 

databases in Measurement & Automation Explorer (MAX). It also allows 

you to convert Citadel 4 databases to the new Citadel 5 format. In addition, 

navigation tools have been added for easier viewing of data sets. 

Revised Historical/Event Logging Configuration
Citadel 5 databases are identified by names instead of paths. So now when 

you select Configure»Historical in the Tag Configuration Editor, a Name 

field is included in the dialog box. For Citadel databases that have not been 

converted to the new Citadel 5 format, the DSC Module Run-Time System 

creates a name for the database using its path and underscores. 

You must give each Citadel 5 database a unique name/path pair. For 

example, you can have a database named Db1 on multiple computers, but 

you cannot have two databases named Db1 on the same computer. Database 

name/path pairs are checked for conflicts whenever you configure 

historical or event logging and when the Tag Engine launches.

When you open a .scf file created in a previous version of the DSC 

Module, you are prompted to convert it and its associated databases to the 

new format. For more information about converting databases, refer to the 

Convert Citadel Databases section.

Tag Monitor Enhancements
Tag Monitor has the following additional features:

• New display columns—Tag Name and Read/Write Attributes.

• New selections available in the Options menu—Type Mismatch 

Checking, XX for Bad Quality, Hex for Raw Data, Set Decimal 

Places, and Select Columns.

Change in Bad Quality Status
The error status for application-defined quality is now a warning instead of 

an error. For example, a thermocouple out-of-range state from FieldPoint 

is now a warning and not a bad-quality error.
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Changes to NI Services
This version of the DSC Module Run-Time System includes a new version 

of the Citadel service, which appears as National Instruments Citadel in 

Windows Services and nicitdl5.exe in the Task Manager. To start and 

stop this or other NI services, use Windows Services available in the 

Control Panel. 

Change to Default Source of Time Stamps
By default, time stamps logged to Citadel with this version come from the 

system clock of the computer running the Tag Engine instead of from the 

server. To have time stamps come from the server, change the 

DSCEngine.ini setting Use Server Timestamps to TRUE. Because 

changing this setting could result in larger Citadel databases, NI 

recommends keeping the default value.

Upgrading Existing DSC Module Applications to 7.0

After installing version 7.0 of LabVIEW and the DSC Module Run-Time 

System, follow the instructions in this section to ensure a smooth 

conversion of your existing DSC Module applications.

Recompile VIs
To run an application created in a previous version of the DSC Module or 

BridgeVIEW, the application VIs must be recompiled in order to upgrade 

them to version 7.0. Recompiling VIs requires development versions of 

both LabVIEW 7.0 and the DSC Module 7.0. 

Convert .scf Files
When you use the Tag Configuration Editor to open a .scf file created in 

a previous version of the DSC Module, a conversion wizard launches and 

leads you through the process of converting your .scf file. The wizard also 

gives you the option of converting existing Citadel 3.x or 4 databases that 

are associated with that .scf file. If the Tag Engine attempts to access a 

.scf file that has not yet been converted, an error is returned.

The conversion wizard saves a renamed backup of the original .scf file to 

the same location as the new, converted .scf. 

Convert Citadel Databases
The DSC Module Run-Time System version 7.0 logs to and retrieves from 

Citadel 5 databases only. You must convert existing databases to Citadel 5 

if you want to use them with the new DSC Module Run-Time System. 
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Databases Associated with a .scf File
When you open a .scf file created in a previous version of the DSC 

Module, a conversion wizard launches. After converting the .scf, the 

wizard gives you the option of converting existing Citadel 3.x or 4 

databases that are associated with that .scf file. 

Caution NI recommends using the default conversion options. If you must save the 

converted database to a location other than the default path due to a shortage of hard drive 

space, for example, your application might not work.

If you attempt to log data from a converted application without first 

converting the database to Citadel 5, the DSC Module Run-Time System 

creates a new, empty Citadel 5 database in the same location as the 

Citadel 4 database and logs data to that new database. To get all the logged 

data back into one database after that happens, you must use the Historical 

Data Viewer to convert the Citadel 4 database and then merge it with the 

new Citadel 5 database.

Databases Not Associated with a .scf File
If you choose not to convert a Citadel database when the wizard asks you, 

or if you have an existing database that is not associated with a converted 

.scf file, you can convert the database using the Historical Data Viewer. 

Click the Historical Data Viewer button, shown at left, in the DSC Module 

Run-Time System window. In the window that opens, right-click the 

Historical Data category, select Create New from the shortcut menu, then 

choose the appropriate conversion in the dialog box that appears. If you 

cannot locate the database you want to convert, you might need to create a 

Citadel 4 version of it in Historical Data Viewer before choosing to convert 

it to Citadel 5.

Remote Databases
You cannot convert a database remotely, or over the network. You must 

convert it on the computer where it exists.

Converted Alarms
Alarm priorities logged by version 6.x of the DSC Module Run-Time 

System ranged from 0–10, and those values are retained when converted 

from Citadel 4 to Citadel 5 format. Alarm priorities logged to Citadel 5 

from version 7.0 of the DSC Module Run-Time System range from 0–15.
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Redirect NI HyperTrend and HTV to Citadel 5 Data
If your application uses the NI HyperTrend control, right-click the control 

on the front panel and select the tags to display so that data is retrieved from 

the converted Citadel 5 database instead of the Citadel 4 database. 

If your application uses Historical Trend Viewer (HTV), launch HTV and 

reselect the tags to display so that data is retrieved from the converted 

Citadel 5 database instead of the Citadel 4 database. 

Create a New ODBC Data Source
For more information about creating an ODBC data source for Citadel 5, 

refer to the Citadel 5 ODBC Data Source section of this document.

Update SQL Queries
If you have existing SQL queries for retrieving historical data, you must 

convert them for use with Citadel 5. Refer to Tables 1 and 2, which detail 

the difference in Citadel 4 and Citadel 5 queries. 

For more information about each Citadel 5 database table, refer to the 

LabVIEW Datalogging and Supervisory Control Module Run-Time System 

Manual, dsc_rts.pdf, in the LabVIEW DSC Run-Time System 7.0\ 

manuals folder.

Table 1.  Changes in Citadel Tables 

Citadel 5 ODBC 

Driver

Citadel 4. x 

ODBC 

Driver  Description 

Aliases N/A Aliases table is used to map alias names to actual tag 

names.

RawData Points RawData table is used to retrieve the actual values logged 

for a tag and times they were logged. You can query only 

one tag at a time.

IntData Traces IntData table is used to retrieve interpolated values. You 

can query more than one tag at a time. 

DS_RawData_ 

dataset_name 

N/A DS_RawData_dataset_name table is used to retrieve the 

actual values logged for a tag, times, and particular data 

set where logged. You can query only one tag at a time. 

DS_IntData_dataset_

name 

N/A DS_IntData_dataset_name table is used to retrieve the 

interpolated values for a particular data set. You can query 

more than one tag at a time.
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Citadel 5 Transform Functions
Transform functions have changed with Citadel 5, as shown in Table 2.

Table 2.  Changes in Transform Functions 

Citadel 5 ODBC Driver 

Citadel 4. x ODBC 

Driver Description 

MATH_MIN(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

MIN(tag) Returns the minimum for tag across the 

interval. 

MATH_MAX(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

MAX(tag) Returns the maximum for tag across the 

interval. 

MATH_AVG(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

AVG(tag) Returns the average for tag across the 

interval. 

MATH_STDEV(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

STDEV(tag) Returns the standard deviation for tag 

across the interval. 

MATH_STARTS(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

STARTS(tag) Returns the number of starts (that is, the 

number of transitions from OFF to ON) 

for tag across the interval. For numeric 

points, 0.0 is interpreted as OFF, and all 

other numbers are treated as ON. 

MATH_STOPS(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

STOPS(tag) Returns the number of stops (that is, the 

number of transitions from ON to OFF) 

for tag across the interval. 

MATH_ETM(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

ETM(tag) Returns the amount of time tag was in 

the ON state across the interval.

MATH_QUAL(tag | 

TO_DISCRETE(tag) | 

TO_CONTINUOUS(tag)) 

QUAL(tag) There might be gaps in the historical 

data traces in Citadel because of 

machine shutdown, Tag Engine 

shutdown, or similar occurrences. 

MATH_QUAL returns the ratio of time 

for which valid data exist for tag across 

the interval to the length of the interval 

itself. If valid data exist for only 

one-half of the interval, MATH_QUAL 

returns 0.5. 
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Standard set functions (MIN, MAX, AVG, COUNT) are supported and you 

can use them on any Citadel 5 table. It is important to distinguish between 

set functions MIN, MAX, AVG, and Citadel 5 transform functions 

MATH_MIN, MATH_MAX, MATH_AVG. Set functions perform 

calculations on query results. Transform functions perform calculations on 

interpolation intervals.

Tag names are forced into an accepted format by replacing characters 

within the names with the characters in Table 3. 

Long Tag Names and Aliases
Database tables and column names can be only up to 126 characters long 

and cannot contain some special characters. Some ODBC clients support 

names only up to 62 characters long. The database URL is not included in 

a tag or data set name. The Citadel 5 driver automatically generates alias 

names for tags or data sets whose names are longer than the Maximum 

Column Name Length value specified in the ODBC configuration dialog 

box. Alias names consist of a prefix and original tag or data set name 

substring, so the total length of the alias string is equal to the Maximum 

Column Name Length value. An alias prefix has the format 

~XXXXXXXXXXXXXXXX_ where XXXXXXXXXXXXXXXX is 

64-bit tag or data set ID. 

TO_DISCRETE(tag) N/A Casts current tag type to discrete (that is, 

the tag is treated as discrete). 

TO_CONTINUOUS(tag) N/A Casts current tag type to continuous 

(that is, the tag is treated as continuous).

Table 3.  Special Access SQL Characters

Special Character Converted Character

period (.) at sign (@)

forward slash (/) backslash (\)

Table 2.  Changes in Transform Functions (Continued)

Citadel 5 ODBC Driver 

Citadel 4. x ODBC 

Driver Description 
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Reimport FieldPoint Configuration

If you communicate with FieldPoint in your DSC Module application using 

the FieldPoint IAK server, sometimes referred to as the FieldPoint 

LabVIEW DSC Server or the FieldPoint VI-Based Server, complete the 

following steps after upgrading to version 7.0 of the DSC Module 

Run-Time System. 

1. Uninstall FieldPoint Explorer if you are using a version earlier 

than 3.0.1. 

2. Download and install a more recent version of FieldPoint Explorer.

• If you install FieldPoint version 3.0.1 or 3.0.2, mass compile the 

FieldPoint IAK server (the contents of the <LABVIEW>\ 

_servers\FieldPoint folder), and export your configuration 

to the DSC Module Run-Time System by selecting 

BridgeVIEW»Export to BridgeVIEW from FieldPoint 

Explorer. 

• If you install FieldPoint version 4.0, save a backup of the .scf 

file then revise it to use the FieldPoint OPC Server, in one of two 

ways:  

– Use the Tag Configuration Wizard to generate a new set of 

tags using the National Instruments.OPCFieldPoint 

server. 

– Edit the configuration of each FieldPoint tag—on the 

Connection tab, change the Server Name to National 

Instruments.OPCFieldPoint. Add the tag to an 

I/O Group, and select the appropriate Item. 

Known Issues

For recent known issues not included in these release notes, refer to the 

dscrt_readme.txt file. This version of the DSC Module Run-Time 

System has the following known issues.

Installation
cwui.ocx cannot be registered on a Windows XP computer that has 

Crystal Report 8 installed. Complete the following steps to work around the 

problem by granting the user full access to the cwui.ocx type library 

registry key and its subkeys.

1. Open the registry editor and select the cwui.ocx key, 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes\TypeLib\ 

{D940E4E4-6079-11CE-88CB-0020AF6845F6}.

2. Select Edit»Permissions and select the appropriate user.
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3. Click the Advanced button, click the Edit button, make sure all 

permissions are set, and click the OK button.

4. Enable the Replace permission entries option and click the Apply 

button.

5. From a command prompt, run regsvr32 cwui.ocx to manually 

register cwui.ocx.

Data Logging and Retrieval

• Quitting the Tag Engine using the Task Manager can corrupt the 

Citadel database.

• Database names cannot contain certain characters. They must contain 

only characters A–Z, a–z, 0–9, and the underscore character ( _ ).

• Periodically, you might see CPU usage at 100% due to Citadel and 

SQL services, even when there are no clients present.

• Converting a large (2 GB or more) Citadel 4 database to Citadel 5 is 

slow.

• In Historical Data Viewer, A&E Views might not work after a 

destructive database archive.

• When changing a HyperTrend y-axis Minimum and Maximum, the 

Apply button does not work; clicking the OK button applies the 

change. When changing a HyperTrend x-axis Width, you must 

right-click the HyperTrend and select Restore X Axis Width from the 

shortcut menu to apply the change.

• If a remote database connection is lost while your client computer is in 

hibernation mode, an NI HyperTrend display on the client computer 

might hang.

• If you try to configure data sets when the Tag Engine is running, you 

can select tags only from the .scf file being used by the Tag Engine.

• If the network connection is lost while performing an archive operation 

to a remote computer, the operation times out and is aborted instead of 

waiting for communication to be reestablished.

• Historical Data Viewer does not display remote alarms unless the 

remote computer is on the same Windows domain.

OPC

• In Server Explorer or Server Browser, browsing to remote OPC servers 

might not work for certain operating systems.

• Even when an OPC server has items “off scan,” the Tag Engine can 

connect to the items and the .scf file sets initial values for the items.
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• The OPC Demo server might not correctly unload when the Tag 

Engine stops. Exit LabVIEW to unload the server.

• In Server Explorer, you might receive error 0x80080005 when trying 

to launch the OPC LabVIEW server.

• The Tag Engine might not shut down as expected after OPC clients are 

disconnected. If the OPC Server goes down, and you try to shut down 

the Tag Engine on the client computer, the Tag Engine might appear to 

hang. However, it is waiting for the timeout period and will shut down 

after the timeout period, which is about three minutes. 

• If you get the message Error Connecting Network Registry when 

attempting to browse OPC server computers across the network under 

Windows Me/98, you must install the Remote Registry Service. For 

more information about installing Remote Registry Service, refer to 

the Microsoft Web article about how to install remote administration 

services.

Communication and Dialog Boxes

• If data is being written to the Tag Engine while an application is 

reading a trend with a large number of samples (100,000 or more) in a 

tight loop, the read might fail.

• When you attempt to start or stop the Tag Engine from the Engine 

Manager window, certain error messages might be placed under the 

Engine Manager window where they cannot be seen.

• The DSC Module Run-Time System might not correctly report bad 

status for disconnected or unavailable FP-1600 modules.

• Tag control values might reset to 0 instead of the LabVIEW default 

value, last value held, or last value logged.

Tag Monitor
In Tag Monitor, denying read privileges causes a Quality of access denied 

for write-only tags. The read/write column values also might not be 

accurate.

ICU License-ICU 1.8.1 and Later

The DSC Module Run-Time System uses code from the International 

Components for Unicode (ICU) libraries, for which the following license 

applies. Refer to oss.software.ibm.com/icu/ for more information 

about the ICU libraries.
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COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995–2002 International Business Machines Corporation 

and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy 

of this software and associated documentation files (the “Software”), to 

deal in the Software without restriction, including without limitation the 

rights to use, copy, modify, merge, publish, distribute, and/or sell copies of 

the Software, and to permit persons to whom the Software is furnished to 

do so, provided that the above copyright notice(s) and this permission 

notice appear in all copies of the Software and that both the above copyright 

notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY 

OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 

LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND 

NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT 

SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN 

THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL 

INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 

PROFITS, WHETHER IN AN ACTION OF CONTRACT, 

NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF 

OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 

SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not 

be used in advertising or otherwise to promote the sale, use or other 

dealings in this Software without prior written authorization of the 

copyright holder.

All trademarks and registered trademarks mentioned herein are the 

property of their respective owners.

More Information and Updates

For information on DSC Module Run-Time System updates and changes in 

the future, visit ni.com/labviewdsc.

To download the newest patches and other updates, visit 

ni.com/downloads.
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